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Creating Searches in Morningstar DirectSM

OverviewHow can Morningstar DirectSM help users when they need to find a set of securities 
with certain characteristics, such as funds belonging to a specific Morningstar 
category, or those with an expense ratio below a particular threshold, or stocks in an 
industry that also have a P/E ratio below a certain number? 

The Search function in Morningstar Direct is the solution to this problem. The Search 
by Criteria window returns a set of investments currently matching whatever criteria 
the user defines.

 Note: Prior to using this training guide, be sure to read the Quick Start Guide for Morningstar 
Direct. Also, this guide builds on the exercises offered in Working with Investment Lists in 
Morningstar Direct.

This window shows 
what a search by 
criteria looks like, 
in this case, for stocks.

The results of a 
search by criteria are 
seen in the grid view.

http://morningstardirect.morningstar.com/clientcomm/DirectOverview.pdf
http://morningstardirect.morningstar.com/clientcomm/DirectOverview.pdf
http://morningstardirect.morningstar.com/clientcomm/Lists.pdf
http://morningstardirect.morningstar.com/clientcomm/Lists.pdf
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What is the 
difference between 
a search and a list?

If a search returns a set of investments, and a list is also a set of investments in 
Morningstar Direct, then what is the difference between the two approaches? 

A search offers dynamic results each time it is run. For example, a search for five-star, 
open-end funds in the Large Value category, would find dozens of funds today, but the 
specific funds seen could (and likely will) change from month to month (because the 
Morningstar Rating is updated monthly). 

An investment list, however, is static and the items on a list do not change unless items 
are manually added to or removed from the list. In other words, the dozens of five-star 
Large Value funds from the search results could be saved to a list, and that list will not 
change unless items are added to it, or removed from it. To learn more about creating 
lists, see Working with Investment Lists in Morningstar Direct.

How do searches 
differ in various parts 
of Morningstar Direct?

Searches can be created (or retrieved) from the following modules:

g Local Databases
gGlobal Databases
gPerformance Reporting
gPortfolio Management
gPortfolio Analysis, and
gWorkspace.

In which module should a search be created? This depends, in part, on what is being 
searched for. For example, if only one type of investment available for sale in your 
country needs to be found, then create that search from the Local Databases module.

The highlighted modules 
indicate modules in 
Morningstar Direct 
where a search can 
be created or retrieved.

http://morningstardirect.morningstar.com/clientcomm/Lists.pdf
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However, if a search needs to consider both open-end funds and exchange-traded 
funds, use either the Workspace or Performance Reporting module to complete 
that search.

Finally, if the ultimate goal is not simply to generate a set of results from a search, but 
to analyze the results by grouping investments, comparing them to benchmarks, and 
applying conditional formatting, the search should be created from the Performance 
Reporting module.

The following exercises offer practice in leveraging the advantages and possible 
limitations of a search created in various areas of Morningstar Direct.
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Working with Simple Searches

OverviewIn a sense, all searches are created equal. No matter how many criteria are selected or 
how they are ordered in the Search by Criteria window, each search requires the 
following actions:

gSelect a field name (i.e., a data point) to evaluate
gChoose an operator (=, <, >, etc.) for the field’s value, and
gAssign a value to the field; this could be a number or a text label.

For example, a very basic search to find funds in the Large Value category would use 
the following criteria:

A search to find funds whose annual net expense ratio is less than or equal to 1.25% 
would look use the following criteria:

This section offers practice with creating some relatively simple searches, as well as 
learning how to save and retrieve searches for later use.

Should I create a search 
to look for investments by 
name or ticker symbol?

In a word, no. While the Search by Criteria window can be used to look for items by 
name or ticker symbol when those values are known, this action takes an 
extraordinarily long time to complete. The number of clicks involved is not worth 
the effort. 

Instead, create a list of known investments from the Workspace module. For details on 
how to create lists, please see Working with Investment Lists in Morningstar Direct.

Field Name Operator Value

Morningstar Category = Large Value

Field Name Operator Value

Annual Net Expense Ratio <= 1.25

http://morningstardirect.morningstar.com/clientcomm/Lists.pdf


Working with Simple Searches Exercise 1: Create a search from the Local Databases module

Morningstar Direct January 2020 8
© 2020 Morningstar. All Rights Reserved.

Exercise 1: Create a 
search from the 
Local Databases module

A search created from the Local Databases module is effectively building on a search 
that already exists. For example, for users in the United States, when the Open End 
Funds page is selected in the Local Databases module and the United States Mutual 
Funds link is selected (see screen shot after step 2 below), this is a search result 
screening for open-end funds for sale in the U.S.

In this first exercise, U.S. Large Value funds will be found. Do the following:

1. From the left-hand navigation pane, select the Local Databases module.

2. Click the Open End Funds page.

3. Click the link for United States Mutual Funds. The database opens.

4. From the toolbar above the spreadsheet view, click the Search icon. The Search by 
Criteria window opens. 

Be sure to select the 
correct page and link.

Click this icon to open the 
Search by Criteria window.
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5. Click in the Field Name cell for the row 1, and select Morningstar Category. The 
Operator cell in the first row defaults to =.

6. Click the Value cell in the first row. Note that the categories are listed alphabetically. 

7. Scroll down and click Large Value.

8. To preview how many investments meet the criterion, click the Run Search button. 

Click to 
select a field.

Note the values 
in these fields.

Use this button to 
see how many items 
match the criteria.
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9. To view the results of the search in the grid view, click OK. In each row, take note of 
what is shown under the Morningstar Category column, and note the Total: number of 
investments showing in the bottom-left corner of the grid view.

All rows now 
show US Fund 
Large Value in 
this column.

The number of 
funds matching 
the search 
parameters is 
shown here.
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Exercise 2: Save a searchSaving a search precludes a user from having to re-enter the criteria again and again 
for those searches used frequently. Once saved, a search is found under the Search 
Criteria folder from the Workspace tab, or it can be opened from the Search window 
itself in other modules. To save a search, do the following:

1. The Open End Funds universe should still be selected within the Local Databases 
module, with United States Mutual Funds showing. From the toolbar above the grid 
view, click the Search icon. The Search by Criteria window opens, and the criterion 
entered earlier should still be showing.

2. From the top of the Search by Criteria window, click the Save As icon. The Save As 
dialog box opens.

Click this icon to re-open 
the Search by Criteria window.

Click this icon 
to save a search.
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3. In the Name field, type Large Value.

4. Click OK to close the dialog box.

5. Click OK to close the Search by Criteria window. The saved search can be opened from 
the Search by Criteria window, or by going to the Workspace module and selecting the 
My Searches page.

Exercise 3: Reset a 
universe after 
conducting a search

Creating the search in Exercise 1 changed the data universe (Open End Funds) selected 
when the exercise began. Now, instead of seeing all open end funds, only open end 
funds in the Large Value category are seen. To reset the universe and return to seeing 
all open end funds with one click, do the following:

From the toolbar above the spreadsheet view, click the name of the universe, in this 
case: United States Mutual Funds.

Enter a name for 
the search here.

Click here to see 
all investments 
again in a universe.
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Exercise 4: Open 
a saved search

Once saved, a search is found under the Search Criteria folder in the Workspace 
module. Alternatively, a saved search can be opened from the Search by Criteria 
window itself anywhere it is accessed in another module, such as the Workspace or 
Performance Reporting modules.

To open a saved search from the Local Databases module, do the following:

1. The Open End Funds universe should still be selected within the Local Databases 
module, with United States Mutual Funds showing. From the toolbar above the 
spreadsheet area, click the Search icon. The Search by Criteria window opens.

2. Click the Open icon. The Open From dialog box opens.

3. Click Large Value, then click OK to close the Open From dialog box.

4. Click OK on the Search by Criteria window to execute the search.

Use this icon 
to recall a 
saved search.

Be sure to select 
the correct search 
from this dialog box.



Working with Simple Searches Exercise 4: Open a saved search

Morningstar Direct January 2020 14
© 2020 Morningstar. All Rights Reserved.

To open a saved search from the Workspace module, do the following:

1. From the left-hand navigation pane, select the Workspace module.

2. Under the Search Criteria folder, select My Search Criteria. If the exercises in the 
Working with Investment Lists in Morningstar Direct guide were completed, the Small 
Value Funds search created and saved as part of that work is seen here. The Small Value 
Funds search did not appear in the previous set of steps (where a saved search was 
opened from the Local Databases module) because the Small Value Funds search 
considered both Open End Mutual Funds and Exchange-Traded Funds, and the search in 
the Local Databases module looks only for Open End Mutual Funds. 

Therefore, when opening a search from the Search by Criteria window in the Local 
Databases (or Global Databases) module searches including other investment types 
cannot be seen.

3. Double-click the Large Value item to open it. Note that the spreadsheet view opens 
with the results, without first showing the Search window.

Note the location 
where you can find saved 
searches in Morningstar Direct.

http://morningstardirect.morningstar.com/clientcomm/Lists.pdf
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Exercise 5: Create a 
simple search 
with multiple criteria

So far, the exercises in this guide have dealt with a search looking for one criterion 
only: Large Value funds. In practice, searches will almost always contain multiple 
criteria, so this exercise explores adding criteria to a search. 

When the Large Value funds search from Exercise1 was run, multiple instances of the 
same funds appeared in the results, rather than just a single instance of each fund. To 
see only one instance of a fund, a few options exist. For instance, a search could look 
for only a certain share class of a fund, such as the A share. 

However, because not all funds have an A share class, using this as an additional 
criterion would eliminate any funds from a search without this feature. Instead, a 
criterion called Oldest Share Class can be used. Oldest Share Class finds only the 
original share class for each fund included in a search. 

Start by opening the search saved in Exercise 2, then build on it. Do the following:

1. Select the Local Databases module, and open the United States Mutual Funds 
universe. From the toolbar above the spreadsheet area, click the Search icon. The 
Search window opens.

2. Click the Open icon. The Open From dialog box opens.

Use this icon 
to recall a 
saved search.
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3. Click Large Value, then click OK to close the Open From dialog box.

4. In the Search by Criteria window, click Run Search, and take note of the number of 
items found.

5. Click in the Field Name cell for the second row, and scroll down until Oldest Share 
Class can be selected. The Operator cell in the second row defaults to =.

 Note: As soon as the Field Name cell for row 2 was clicked, the word “And” appeared in the 
Rel(ationship) column. This means both of these criteria (in rows 1 and 2) must be true in order 
for a fund to be returned by the search. Also, rather than scrolling down to find a criterion, 
another option is to type the word Old, and the cursor would jump to find Oldest Share Class.

6. Click in the Value cell for row 2 and select Yes.

7. Click Run Search again, and note the number of funds that are now found.

Be sure to select 
the correct search 
from this dialog box.

Note the values 
in these fields.
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8. Two criteria should now appear in the search for Large Value funds. To re-save the 
search to reflect this change, click Save As. The Save As dialog box opens.

9. Under the Existing Searches area, double-click Large Value; this populates its value in 
the Name field.

10. Click OK.

11. When the overwrite confirmation message opens, click OK. Keep the Search by Criteria 
window open for the next exercise.

Double-click the name 
of an existing search to 
override that item with 
the current content in the 
Search by Criteria window.



Working with Simple Searches Exercise 6: Expand a search to another category

Morningstar Direct January 2020 18
© 2020 Morningstar. All Rights Reserved.

Exercise 6: Expand a 
search to 
another category

By default, the Search by Criteria window shows the available search criteria by 
grouping data points into categories. These categories are identical to the pre-built 
views available in the Local Databases grid view. If the category (or view) a data point 
appears in is known, it’s easy to find that field for inclusion in a search. Note that some 
fields, such as Ticker or Morningstar Rating, appear in more than one search category 
(and pre-built view).

So far, the two criteria (Morningstar Category and Oldest Share Class) used in creating 
searches have appeared in the default Snapshot category, which is expanded by 
default when the Search by Criteria window is opened. Seeing fields grouped by 
category is the default setting when working with the Search by Criteria window.

While seeing the Snapshot category expanded by default is convenient for selecting 
the most popular fields being sought (which is the intent of the Snapshot 
view/category), this category does not allow users to access all of the criteria that may 
be needed for every search. For example, what if the need is to eliminate any fund from 
a search not open to new investors? No criterion exists for “Open to New Investors.” 
Instead, an alternative approach needs to be taken in order to see these funds. 
Specifically, the search needs to look for those instances where funds have not been 
closed to new investors.

The categories here 
correspond to the 
views in a universe.

Note the default 
display by which 
criteria are found.

The views here are 
reflected in the category 
groupings in the 
Search by Criteria window.
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To find funds still open to new investors, do the following:

1. The Search by Criteria window should still be open, with the criteria from the Large 
Value search still displayed. (If not, open the saved search now.)

2. In row 3, click in the Field Name cell. 

 Note: Again, the word “And” appears in the Rel column for row 3.

3. Scroll up to the top of the Field Name list, and collapse the Snapshot category by 
clicking once on the icon to the left of its name.

4. Click the icon to the left of the Operations category to expand it.

Click the icon to the 
left of Snapshot to 
collapse the category.

Click the icon to the 
left of Operations to 
expand the category.
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5. Scroll down in the Operations category and click Closed to New Inv.

6. In the Operator cell for row 3, select Not =.

7. In the Value cell for row 3, select Yes.

8. Click Run Search. The number of items found now reflects the inclusion of this 
additional criterion. Because the Rel(ationship) column for all three rows is “And,” all 
three criteria must be true for a fund in order for it to be found by the search.

9. Re-save the search again to include this latest change. Click the Save As icon. The 
Save As dialog box opens.

10. Under the Existing Searches area, double-click Large Value; this populates its value in 
the Name field.

11. Click OK to close the Save As dialog box.

12. When the overwrite confirmation message opens, click OK. Keep the Search by Criteria 
window open for the next exercise.

The field appears 
under the 
Operations 
category.

Note the values 
for this row.
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Exercise 7: Look for 
a field by name

By default, the Search by Criteria window allows users to select criteria based on the 
category each data point is assigned to. This makes finding a particular data point 
easy, as long as its known under which category each one is found. What happens, 
though, when this isn’t known? Rather than waste a lot of time expanding, scrolling, 
and collapsing categories to find a data point, it will be faster to see all fields listed 
alphabetically, regardless of the category in which it appears.

To find and select a data point by name, do the following:

1. The Search by Criteria window should still be open, with the criteria from the Large 
Value search still displayed. (If not, open the saved search now.)

2. In the bottom-left corner of the Search by Criteria window, select the option 
for Alphabetically. 

Select this 
option to see all 
criteria at once.
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3. In row 4, click in the Field Name cell. All criteria are now listed alphabetically.

 Note: Again, the word “And” appears in the Rel column for row 4.

4. Type Up. The list of data points automatically jumps to Upside Capture Ratio 1 Yr 
(Mo-End). Click Upside Capture Ratio 1 Yr (Mo-End).

5. In the Operator cell for row 4, select >=.

The fields all appear in 
alphabetical order; those 
with symbols and 
numbers at the start of 
their names appear first.

As a data point’s 
name is typed, 
the list moves 
to that location.
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6. In the Value field for row 4, enter 100. This line now looks for only those funds achieving 
at least 100% of the upside of the market over the past year.

7. Click Run Search.

8. Click the Save As icon. The Save As dialog box opens.

9. Under the Existing Searches area, double-click Large Value; this populates its value in 
the Name field.

10. Click OK to close the Save As dialog box.

11. When the overwrite confirmation message opens, click OK. Keep the Search by Criteria 
window open for the next exercise.

Note the values 
for this row.
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Exercise 8: Update the 
system user preferences 
to find the cheapest 
share class of a fund

When searching for only one instance of a fund, look for one of the following options:

g the oldest share class of a fund
g a specific share class for a fund, such as the A share, or
g the least expensive share class for a fund. 

The first example has already been explored. The second example is achieved simply by 
selecting the Share Class Type data point, then choosing the appropriate value. When 
searching for only the cheapest share class for a fund, however, the first step is to set 
the proper user preference from the File menu because no field exists to search on 
called “Cheapest Share Class.” Once the correct user preference is set, a check box on 
the Search by Criteria window can be used to activate it and make it part of a search.

To create a user preference prioritizing the cheapest share class of a fund (over other 
share classes), do the following:

1. On the menu bar at the top of the Morningstar Direct window, from the File menu, select 
Set User Preferences. The Set User Preferences window opens.

Select this option 
from the File menu.
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2. Select the User Defined Primary tab.

3. Select the row for Annual Report Net Expense Ratio, then click the move to top 
button. (The move to top button displays two up arrows.) This ensures this element takes 
precedence when conducting a search.

4. Be sure the word Lowest appears in the Choose column.

5. Click OK. In the next exercise, this setting will be applied to a search.

Click this button to 
move the selected 
item to the top of the list.
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Exercise 9: Create 
a search by criteria in 
the Workspace module

In this exercise, large growth funds (both open-end funds and ETFs) meeting the 
following criteria will be found:

g an expense ratio below the category average
g still open to new investors
g an above-average Sharpe Ratio for the trailing five-year period, when compared to 

their category peers
g a Downside Capture Ratio below 100 for the five-year period, and
ghave been around for at least five years.

Because both open end funds and exchange-traded funds are being sought at once, 
this search should be created from the Workspace module, where a search can look 
across multiple universes simultaneously. Additionally, the following exercise uses a 
check box on the Search by Criteria window that heretofore has not been used.

To create this search in the Workspace module, do the following:

1. In Morningstar Direct, select the Workspace tab.

2. Under the Search Criteria folder, select My Search Criteria.

3. From the toolbar above the grid view, select New > Advanced Search > Funds 
(Open End and Exchange-Traded Funds). The Search by Criteria window opens.

Select this 
universe as 
the source 
for the search.

Note the 
location 
where the 
search should 
be created.
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4. Set the criteria as shown in the following table. At the bottom of the Search by Criteria 
window, be sure to check the checkbox for User Defined Primary Class Only.

 

 *Note: Change this date value to the previous month-end period from five years ago. When 
using date fields, note that < means “before,” while > means “after.”

5. Click Save As.

6. Name the search Large Growth Watch List.

7. Click Run Search. 

 Note: The number shown here does not reflect those funds to be eliminated when the User 
Defined Primary Class rule is applied. This reduction is seen only after the Search by Criteria 
window is closed.

8. Click OK to close the Search by Criteria window. 

9. Take note of the number of funds shown in the grid view. How does this compare to the 
number seen after clicking Run Search in step 7? Note, too, that only one share class of 
a fund is showing, although different share class types are represented.

Rel ( Field Name Operator Value )

-- Morningstar Category = US Large Growth

And Annual Report Net Expense Ratio < CAT AVG

And Closed to New Inv Not= Yes

And Sharpe Ratio 5 Yr (Mo-End) > CAT AVG

And Downside Capture Ratio 5 Yr (Mo-End) < 100

And Inception Date <= 1/1/2014*

Be sure your 
search reflects the 
inputs shown here.

Remember to check 
this box as well.
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Final lessons on 
creating simple searches

A simple search uses the same relationship (namely, “And”) between all rows, no 
matter how many criteria are included in the search. The following are some additional 
notes to reflect on when creating simple searches:

gSearches can be created in Morningstar Direct from the Local Databases, Global 
Databases, Workspace, Performance Reporting, and other modules, depending on 
the need.

gUsers can select search criteria fields within a pre-built category, or by seeing them 
listed alphabetically.

gWhen looking for data points alphabetically, type the beginning of a data point’s 
name to jump to that spot in the list.

g Fields taking a numeric value, such as Annual Report Net Expense Ratio, can often 
be entered either as a number or as a comparison to the category average.

g Each time a criterion is added to a search, click the Run Search button to ensure it 
does not turn out that 0 results are found. If this happens, it indicates a parameter 
of the search needs to be changed. 

gSearches can be saved, to keep users from having to re-enter the same criteria over 
and over, but remember that the results seen each time a saved search is opened 
could change.

gSaved searches are found under the Workspace module (on the My Searches 
page), and these saved search files can be shared with or sent to other 
Morningstar Direct users, just as with lists.

gUse the User Defined Primary preference (available from the File menu) to include 
in a search an additional layer to eliminate all but one type of share class.
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Creating Complex Searches

OverviewThus far, the searches created have been fairly simple. Although multiple criteria have 
been used, all of the rows in the Search by Criteria window are linked by the “And” 
relationship. At times, a more sophisticated search may be needed where the 
relationship between rows is more complicated and additional capabilities of the 
Search by Criteria window are needed. This section covers the following topics:

gusing parentheses within the Search by Criteria window to create 
complex searches
g inserting additional rows into an existing search, and 
gmonitoring the relationship between rows as a complex search is built.

Exercise 10: Create a 
search across multiple 
Morningstar categories

The search so far looks at the Large Value category for the oldest share class of 
open-end funds, still open to new investors, with a 1-year upside capture ratio of at 
least 100%. What if the goal is to see funds matching these criteria not just in the 
Large Value category, but also in the Large Blend and Large Growth categories? This 
can be done by building on the saved search, rather than creating three separate 
searches. Do the following:

1. From the left-hand navigation pane, select the Local Databases module.

2. If needed, select the Open End Funds page.

3. Click the link for United States Mutual Funds. The database opens.

Be sure to 
select the 
correct page 
and link.
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4. From the toolbar above the spreadsheet view, click the Search icon. The Search by 
Criteria window opens. 

5. Click the Open icon. The Open From dialog box opens.

Click this icon to open the 
Search by Criteria window.

Use this icon 
to recall a 
saved search.
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6. Click Large Value, then click OK to close the Open From dialog box.

7. The next step is to insert a new row. An insertion always goes above the selected row. 
To insert a row between rows 1 and 2, select the checkbox to the left of row 2. 

Be sure to select 
the correct search 
from this dialog box.

Check the box 
below the row 
where a new 
row should 
be inserted.
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8. From the toolbar, click the Insert icon. A blank row is inserted between rows 1 and 2.

9. In new row (2), click the Rel column, then select Repeat. The data from the row above is 
copied into row 2.

Click this icon to 
insert a new row 
above the 
highlighted row.

Choosing 
Repeat copies 
the content from 
the row above.
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10. The Field Name and Operator cells for row 2 should stay the same. Click the Value cell 
for row 2, and select Large Blend.

11. Repeat steps 6–10 to insert another new row for Large Growth funds.

12. Click Run Search. The number of funds returned seems unexpectedly high. This 
indicates the search needs modification. Specifically, the first three lines of the search 
need to be encapsulated in parentheses, to tell the system to consider them as one 
object. Otherwise, the system searches for any Large Value fund, or any Large Blend 
fund, or the oldest share class of Large Growth funds still open to new investors with an 
upside capture ratio of at least 100%.

When a row 
is repeated, 
only the Value 
cell needs 
to change.

This number 
is far higher 
than expected 
based on 
the criteria 
being used.
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13. In the ( cell of row 1, type (.

14. In the ) cell of row 3, type ).

15. Click Run Search. Note the much lower number of funds returned.

16. Save this search as a new item. Click the Save As icon.

17. In the Name field, type Open Large Cap Funds.

18. Click OK to close the Save As dialog box. 

19. Click OK to close the Search by Criteria window.

Note the 
placement of 
parentheses.

Note the name 
for the new search.
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Exercise 11: Create two 
searches at once

The last exercise showed how to use a set of parentheses to encapsulate a single set of 
criteria. What if the goal is to look for two separate sets of data at once? For example, 
imagine the need is to find value-oriented funds with a P/E ratio of no more than 17, 
and growth-oriented funds that have a P/E ratio of at least 17? This type of search 
requires multiple instances of parentheses. 

To create two searches at once, do the following:

1. From the left-hand navigation pane, click the Workspace module.

2. Under the Search Criteria folder, select My Search Criteria. 

3. From the toolbar above the grid view, select New > Advanced Search > 
Funds (Open End and Exchange Traded Funds). The Search by Criteria window opens.

Select this 
universe 
to search within.

Note the 
location 
where the 
search should 
be created.
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4. Create a search with the following criteria:

 Note: Remember to use the Repeat option from the Rel column to avoid having to select the 
same field name multiple times. Selecting the Alphabetically button in the lower-left corner 
of the dialog box can help find the criteria more quickly.

5. Click the Run Search button, to see how many funds match the search.

6. Click the Save As icon. The Save As dialog box opens.

7. In the Name field, type Multiple Searches.

8. Click OK to close the Save As dialog box.

9. Click OK to close the Search by Criteria window. 

 Note: In the search results (seen in the grid view), check your work by sorting on the 
Morningstar Category column (click once on a column’s header to sort by that column), and 
also by examining the P/E Ratio (TTM) (Long) statistic, which is available from the 
Equity Port Stats (Long) view.

Rel ( Field Name Operator Value )

-- ( Morningstar Category = U.S. > Large Value

Or Morningstar Category = U.S. > Mid-Cap Value

Or Morningstar Category = U.S. > Small Value )

And P/E Ratio TTM (Long) <= 17

Or ( Morningstar Category = U.S. > Large Growth

Or Morningstar Category = U.S. > Mid-Cap Growth

Or Morningstar Category = U.S. > Small Growth )

And P/E Ratio (TTM) (Long) > 17

And Oldest Share Class = Yes

Your Search 
by Criteria 
window 
should reflect 
this image.
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Final lessons on creating 
advanced searches

An advanced search uses relationships (And, Or) between rows, and can also include 
the use of parentheses. When creating advanced searches, keep in mind the following 
additional notes:

gWhen the same Field Name is used for multiple consecutive rows, but a different 
Value, encapsulate the rows with parentheses, and use “Or” as the Rel(ationship) 
among them. In the row for the next criterion, remember to change the Rel column 
to “And.”

gSelecting “Repeat” from the Rel column is an easy way to copy data from the row 
above, and saves a few clicks from making a selection for every cell in a row.

gCriteria can be nested in multiple levels through the proper use of both 
parentheses and the relationship between rows.

gRows can be inserted between data points in the Search by Criteria window; 
remember that the inserted row appears above the selected row.
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Additional Practice Exercises

OverviewThe following exercises challenge you to build searches within Morningstar Direct on 
your own. Can you select the correct data points, relationships, operators, and values, 
and use parentheses correctly when needed? A link to the solution for each exercise is 
also provided.

Exercise 12: Find 
passively managed 
funds in a 
Morningstar Category

How many passively managed open-end funds and ETFs in the Mid-Cap Value category 
are for sale in the U.S.? Only one instance of each fund needs to be shown. What 
should the Search by Criteria window look like for this search? The following hints will 
help with this exercise:

1. Create the search from the Workspace module.

2. Search within the Funds (Open End and Exchange-Traded Funds) universe. 

3. To find passive funds, opt to see the criteria listed alphabetically, and look for a field 
called “Index Fund.”

Now check your work: Solution to Exercise 12.

Exercise 13: Find the 
annual return 
values for Morningstar 
Stock Sector indexes

Morningstar divides stocks into 11 sectors and three Super Sectors. What are the Total 
Return 1-Yr (Mo-End) values for the Total Return series of Morningstar Indexes based 
on the Morningstar Stock Sectors? The following hints will help with this exercise:

1. The search can be created from the Market Indexes universe under the 
Local Databases module.

2. The Series Name for the indexes you are searching for is Morningstar US Sector.

3. Total Return indexes can be found by looking for Return Type = Total Return.

4. Note that the search results will encompass the indexes tied to both the Morningstar 
stock sectors, and the Super Sectors, as well as certain specialty sector indexes.

5. The one-year return values can be seen from the pre-built Returns (Month-End) view.

Now check your work: Solution to Exercise 13.
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Exercise 14: Find socially 
responsible separate 
accounts and CITs

How many separate accounts or collective investment trusts (CITs) in the Diversified 
Emerging Markets or Emerging Markets Bond institutional categories self-identify 
as sustainable funds? 

 Note: The Morningstar Institutional Categories were launched in May 2009 in response to 
feedback from institutional clients of Morningstar. They felt the Morningstar Categories are 
typically too broad to support their business processes, such as manager compensation 
discussions and expense peer grouping. The Morningstar Institutional Categories were 
developed to address those needs by using more granular definitions to assign portfolios to 
peer groups. The result is a system with many more categories that more thoroughly identify 
distinct investment strategies.

The Morningstar Institutional Categories allocate portfolios into peer groups using the same 
holdings-based methodology already employed by the Morningstar Categories, which were 
introduced in 1996. The two structures are also parallel in that one category is assigned to 
each portfolio in the managed funds database at Morningstar. The key difference is that the 
Institutional Categories have narrower parameters, allowing for more sophisticated and 
detailed peer group comparisons. This new system is intended to help institutional investors 
identify true peers, build more thoroughly diversified portfolios, and gain more insight into an 
individual portfolio’s strategy. 

The following hints will help with this exercise:

1. Because the search involves two distinct investment universes, it should not be created 
from the Local Databases module.

2. When looking for the Diversified Emerging Markets and Emerging Markets Bond 
institutional category values, be sure to select Morningstar Institutional Category as the 
Field Name.

3. Remember to use parentheses to enclose multiple criteria that have the same 
Field Name, but different Values, and use Or as the Rel(ationship) between those rows.

4. The Sustainable Investment - Overall criterion can be found under the Sustainability 
category grouping.

Now check your work: Solution to Exercise 14.
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Solution to Exercise 12For Exercise 12, the Search by Criteria window should look like the following:

To reproduce this search, do the following:

1. From the left-hand navigation pane, click the Workspace module.

2. Under the Search Criteria folder, select My Search Criteria. 

3. From the toolbar above the grid view, select New > Advanced Search >
Funds (Open End and Exchange-Traded Funds). The Search by Criteria window opens.

Be sure to 
search within 
this universe 
from the 
Workspace 
module.

Search within 
this universe.
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4. Create a search with the following criteria:

 Note: Selecting the Alphabetically button in the lower-left corner of the dialog box can help 
find the criteria more quickly.

5. Click OK.

Rel Field Name Operator Value

-- Morningstar Category = U.S. > Mid-Cap Value

And Index Fund = Yes

And Oldest Share Class = Yes
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Solution to Exercise 13For Exercise 13, the Search by Criteria window should look like the following:

The following results should be seen:

 Note: The exact market return values you see will differ from those shown here.

Be sure to search 
within this universe 
from the Local 
Databases module.

Note the view 
to select to see 
the return values.

Scroll right to 
see this column.
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To see these same results, do the following:

1. In the left-hand navigation pane, select the Local Databases module.

2. Click the Market Indexes page. 

3. Under the Morningstar-defined Universes list, click the Global Indexes in USD universe.

Click to open 
this universe.
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4. From the toolbar above the grid view, click the Search icon. The search by criteria 
window opens.

Note the location 
where you should be 
before clicking this icon.
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5. Create a search with the following criteria:

6. From the View drop-down field, select Returns (Month End). Scroll right to see the 
values in the Total Return 1 Yr (Mo-End) column.

Rel Field Name Operator Value

-- Series Name = Morningstar US Sector

And Return Type = Total Return

Scroll to 
the top of 
the 
drop-down 
list in this 
field to 
make this 
selection.

Note the view 
to select to see 
the return values.

Note the values 
in this column.



Additional Practice Exercises Solution to Exercise 14

Morningstar Direct January 2020 46
© 2020 Morningstar. All Rights Reserved.

Solution to Exercise 14For Exercise 14, the Search by Criteria window should look like the following:

To see these same results, do the following:

1. From the left-hand navigation pane, click the Workspace module.

2. Under the Search Criteria folder, select My Search Criteria. 

3. From the toolbar above the grid view, select New > Advanced Search >
All Managed Investments. The Search by Criteria window opens.

Be sure to search 
within this universe 
from the Local 
Databases module.

Search within 
this universe.

This search 
needs to be 
created from 
the Workspace 
module.
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4. Create a search with the following criteria:

 Note: Remember to use the Repeat option from the Rel column to avoid having to select the 
same Field Name multiple times. Selecting the Alphabetically button in the lower-left corner 
of the dialog box can help find the criteria more quickly.

5. Click the Run Search button, to see how many investments match the search.

6. Click the Save As icon. The Save As dialog box opens.

7. In the Name field, type Sustainable Investment CITs/SAs.

8. Click OK to close the Save As dialog box.

9. Click OK to close the Search by Criteria window. 

Rel ( Field Name Operator Value )

-- ( Investment Type = Collective Investment Trusts

Or Investment Type = Separate Account )

And ( Morningstar Institutional Category = Diversified Emerging Markets

Or Morningstar Institutional Category = Emerging Markets Bond )

And Sustainable Investment - Overall = Yes

Your Search 
by Criteria 
window 
should reflect 
this image.


	Overview
	What is the difference between a search and a list?
	How do searches differ in various parts of Morningstar Direct?
	Working with Simple Searches
	Overview
	Should I create a search to look for investments by name or ticker symbol?
	Exercise 1: Create a search from the Local Databases module
	Exercise 2: Save a search
	Exercise 3: Reset a universe after conducting a search
	Exercise 4: Open a saved search
	Exercise 5: Create a simple search with multiple criteria
	Exercise 6: Expand a search to another category
	Exercise 7: Look for a field by name
	Exercise 8: Update the system user preferences to find the cheapest share class of a fund
	Exercise 9: Create a search by criteria in the Workspace module
	Final lessons on creating simple searches

	Creating Complex Searches
	Overview
	Exercise 10: Create a search across multiple Morningstar categories
	Exercise 11: Create two searches at once
	Final lessons on creating advanced searches

	Additional Practice Exercises
	Overview
	Exercise 12: Find passively managed funds in a Morningstar Category
	Exercise 13: Find the annual return values for Morningstar Stock Sector indexes
	Exercise 14: Find socially responsible separate accounts and CITs
	Solution to Exercise 12
	Solution to Exercise 13
	Solution to Exercise 14


